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19.1 Introduction

Silverlight™, formerly code named “Windows Presentation Foundation Everywhere
(WPE/E),” is Microsoft’s platform for Rich Internet Applications (RIAs). It is designed
to complement Ajax and other RIA technologies, such as Adobe Flash and Flex, Sun’s
JavaFX and Microsoft’s own ASP.NET Ajax. Silverlight currently runs as a browser plug-
in for Internet Explorer, Firefox and Safari on recent versions of Microsoft Windows and
Mac OS X. In addition, developers from the Mono project (www . mono-project .com) are
developing an open-source implementation of Silverlight for Linux distributions called
Moonlight.

Microsofi announced Silverlight 1.0 Beta and 1.1 Alpha at the 2007 MIX conference
(www.visitmix.com), Microsoft's annual conference for web developers and designers.
The demos were compelling, and many technology bloggers who attended the conference
blogged about Silveright's excitement and potential. Since then, Microsoft has continued
developing and enhancing Silverlight. At the time of this writing, Silverlight is currently
available in version 1.0 Release Candidate and version 1.1 Alpha Refresh.

Despite the generally unstable nature of alpha-level software, we felt compelled to
include examples using the Silverlight 1.1 Alpha Refresh because of Silverlight 1.1°s poten-
tial to become an important RIA development platform. Silverlight 1.1 is still early in its
development cycle, so you may encounter bugs while running this software. Also, it is pos-
sible thar Silverlight 1.1 will change substantially in future releases, breaking our 1.1 based
example applications. For updated examples, please visit our website for this book at
www. deitel . com/books/iw3htp4/. For information on the latest version(s) of Silverlight
and to find additional Silverlight web resources, please visit our Silverlight Resource
Center at www.deitel.com/silverlight.
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19.2 Platform Overview

Silverlight applications consist of a user interface described in Extensible Application
Markup Language (XAML) and a code-behind file (or files) containing the program
logic. XAML (pronounced “zammel”) is Microsoft’s XML vocabulary for describing user
interfaces and is also used in Microsoft’s Windows Presentation Foundation (WPF)—the
preferred user-interface technology of the NET Platform as of version 3.0.

Silverlight currently runs in Internet Explorer 6+ and Firefox 1.5.0.8+ on Windows
XP 5P2 and Vista, as well as Safari 2.0.4+ and Firefox 1.5.0.8+ on Mac OS X. Support for
Windows 2000 and for the Opera browser is planned in a future release.

Silverlight 1.0 focuses primarily on media and supports programming only in Java-
Script. [ts primary purpose is to take advantage of the increasing popularity of web-based
video ro drive user adoption—it is well known that users are willing to install software to
watch video. Microsoft also provides a service called Silverlight Streaming that allows you
to distribute video-based Silverlight applications for free.

When Silverlight 1.1 is released, computers with Silverlight 1.0 will automatically be
upgraded. This could immediately make Silverlight 1.1 a widespread platform for RIA
development. Silverlight 1.1’s key benefit is that it adds an implementation of the .NET
runtime, allowing developers to create Silverlight applications in .NET languages such as
Visual Basic, Visual C#, IronRuby and IronPython. This makes it easy for developers
familiar with .NET programming for Windows to create applications that run in a web
browser. Two of our 1.1 Alpha Refresh examples borrow their user interfaces and code
from examples in our Visual Basic 2005 How ro Program, 3/ wexibook. This straightfor-
ward conversion was made possible by Silverlight 1.1s NET runtime and 2 set of third-
party Silverlight user-interface controls (available atr www.netikatech. com) designed 1o
replicate the srandard Windows Forms controls. Microsoft plans to implement their own
built-in set of controls in a future release of Silverlight 1.1. Version 1.1 also provides a sub-
stantial performance improvement over 1.0 because .NET code is compiled by the devel-
oper then executed on the client, unlike JavaScript, which is intetpreted and executed on
the client at runtime. For a detailed feature comparison of 1.0 Release Candidate and 1.1
Alpha Refresh, visit silverlight.net/GetStarted/overview. aspx.

19.3 Silverlight 1.0 Installation and Overview

You can download the Silverlight 1.0 Release Candidate plug-in from www.microsoft. com/
silveriight/install.aspx. After installing the plug-in, go to silverlight.net/themes/
silverlight/community/gallerydetail.aspx?cat=1and try some of the sample applica-
tions. We list many other demo websites in Section 19.11.

We developed our Silverlight 1.0 application using Microsoft’s Expression Blend 2,
a WYSIWYG editor for XAML user interfaces. You can download a free trial of Expression
Blend 2 from

wow.microsoft. com/Expression/products/down]oad. aspx?key=blend2preview

Follow the instructions on the web page to install the software. Note that Expression
Blend runs only on Windows XP SP2 and Vista. Also, note that you do not need to install
Visual Studio 2005 Express.
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19.4 Creating a Movie Viewer for Silverlight 1.0

Our first example application is a movie viewer (Fig. 19.1) that plays Windows Media
Video (WMYV) videos. This example runs on Silverlight 1.0 Release Candidate, and the
user interface was created using Expression Blend 2 August Preview. The XAML was gen-
erated primarily by Expression Blend. We discuss the XAML as we show you how to build
the user interface.

The movie viewer's GUI includes play/pause, stop and full-screen buttons, a timeline
with a marker at the current time, a volume control and thumbnails of other videos that
you can view. The timeline also shows the percentage of the video that has been down-
loaded. In this example, you'll learn 1o create user interfaces in XAML and to use Java-
Script to handle events. We'll also demonstrate how to use JavaScript to manipulate the
Silverlight DOM (Document Object Model). You can test a live version of this applica-
tion at test.deitel.com/examples/iw3htpd/silverlight/MovieViewer/i ndex.html.

To create the project in Expression Blend, open Expression Blend and select New
Project in the Project tab. To create a Silverlight 1.0 application, sclect Silverlight Applica-
tion {JavaScript). Name the project MovieViewer and select the location where you would
like to save it.

Fig. 19.1 | Silverlight Movie Viewer.

19.4.1 Creating a User Interface In XAML Using Expression Blend

To show how XAML works, we first creatc clements in Expression Blend, then discuss the
corresponding generated XAML in Scene . xaml (which you'll see in Fig. 19.12).
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Canvas Elements

The root element of the XAML file is a Canvas element. A Canvas element acts as a con-
tainer for other user interface elements and controls their position. The parent Canvas cle-
ment is created when you create a new Silverlight project in Expression Blend. The parent
Canvas has a default Name of Page, width of 640 px and Height of 480 px. The Name
attribute provides an ID to access the clement programmatically. The Canvas’s properties
can be edited in the Properties panel (Fig. 19.2). Additional Canvas clements can be
created in Expression Blend using the Canvas tool in the toolbar, shown in Fig. 19.3. The
XAML can be manually edited by selecting XAML in Expression Blend’s View menu.

Fig. 19.2 | Expression Blend's Properties inspector.

Fig. 19.3 | Expression Blend's toolbar.
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19.4.2 Using Storyboards

The Storyboard element allows you to define animations. In Expression Blend, you can -
create 2 Storyboard by opening the Open, create or manage Storyboards panel and click-
ing the Create new Storyboard button (Fig. 19.4). Select the Create as a Resource check-
box (Fig. 19.5). This enables you to start the Storyboard from anywhere in the
application’s JavaScript at any time (as opposed to starting the Storyboard automatically
when the application loads). Name the Storyboard timelineTimer and click OK. This
Storyboard will be used as a timer, because a dedicated timer object does not exist in Sil-
verlight 1.0. A Storyboard must have a target object, so we will create an invisible object.
Create 2 Rectangle of any size in any location using the Rectangle tool, name it invisi-
bleRectangle, then set its Visiblity to Collapsed using the Properties panel. Move the time-
line playhcad to 0.1 seconds, then click the Record Keyframe button (Fig. 19.6). In this

Fig. 19.4 | Expression Blend’s Objects and Timeline inspector.

Create Storyboard

Fig. 19.5 | FExpression Blend’s Create Storyboard dialog box.

Fig. 19.6 | Objects and Timeline inspector showing the TimelineTimer Storyboard.
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new keyframe, change any property of the rectangle. If you create the keyframe withour
changing a property, the Storybeard will not do anything. Close the Storyboard by open-
ing the Open, create or manage Storyboards menu and clicking Close Storyboard.

Expression Blend provides the Gradient brush tool (Fig. 19.7) to visually create and
modify gradients. First, use the Selection tool to select the Page Canvas in the design area.
Then, select the Gradient brush for the Background and select the gradient slider on the
right (Fig. 19.7). Change the red, green and blue values to 71.

Fig. 19.7 | Expression Blend's Brushes inspector.

19.4.3 Creating Controls ,

We use 2 TextBlock element to display Silverlight Movie Viewer at the top of the page. Cre-
ate this element using Expression Blend’s TextBlock tool, name the element titleText,
then change to the Solid color brush in the Brushes inspector and use the color selector to
make the text white. Adjust the text size in the Text inspector to 24 (Fig. 19.8).

Next, we create another Canvas element called controls, using the Canvas tool. The
controls Canvas will contain the application’s buttons, which are themselves Canvases.
This Canvas is a child of the Page Canvas element. Create this Canvas at the bottom of
the application, spanning the width of the application. Set the Height to 160 and make sure
that the Canvas is at the bottom of the application by moving it until it snaps into place.

Fig. 19.8 | Expression Blend’s Text inspector.

Creating the Video Thumbnail Buttons :
For each video, we create a button consisting of the video’s thumbnail and tdde. Double-
click the controls Canvas with the Selection tool to activate it, then create four new Canvases
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in the controls Canvas. Set cach Canvas’s Width to 120 and Height to 114. In each
Canvas, create an Image element, with the Source attribute pointing to the video's thumb-
nail JPEG image, for example baileyThumb. jpg (Fig. 19.9). You can select the Image tool
by dicking the Asset Library button (Fig, 19.3), checking Show All and selecting Image
(Fig. 19.10). Set the Image’s Width and Height to 120 and 0, and place it at the top of the
Canvas. Add a TextBlock containing the text Crazy Dog. Do the same for the other three
Canvascs, setting the Image’s Sources to featherAndHammerThumb. jpg, apoltlolsLaunch-
Thumb. jpg and F35Thumb.jpg. The TextBlocks for the three Canvases should contain
Gravity, Apollo 15 and F35 Landing, respectively. Name the Canvases crazyDogButton,
gravityButton, apollol5Button, and f35Button, and space them evenly across the con-
trols Canvas. Finally, to make each of these Canvases appear to act like a button, we will set
their Cursor properties to Hand in the Common Properties inspector. This way, the user’s
cursor will change to a hand when the cursor is moved over each button Canvas.

Asset Libruty

Fig. 19.10 | Expression Blend's Asset Library.

Creating the Video Playback Control Buttons

Next, we create a play button, a stop button, a pause button, and a full-screen button.
These buttons are all contained in the controls Canvas. To create the play butron, first
create a Canvas named playButton, then set its Width and Height to 30. Set the RadiusX
and RadiusY to 2 to give the burton rounded corners. These propetties are located in the
advanced properties section of the Appearance inspector (Fig. 19.11). Inside this Canvas,
use the Rectangle tool to draw a Rectangle with the same width and height as the Canvas,
and ser its background to a gradient going from dark blue to light blue. Then, using the
Pen tool, draw two Paths to make an arrow pointing right (a play bucton). Use the Pen
tool to click once at each endpoint of the line. After drawing each line, use the Select tool
to move the line into place. The Path element allows you to draw shapes that include
curves and arcs, but here we are just using it to draw simple lines. Set each Path’s Stroke
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Fig. 19.11 | Expression Blend's Appearance inspector.

color to white. Set the StrokeThickness property in the Appearance inspector to 4, Set each
Path’s StrokeEndLineCap and StrokeStartLineCap to Round in the Appearance inspector.
Finally, set the Cursor property of the playButton Canvas to Hand.

Copy the playButton Canvas and paste it three times. Move one copy just to the right
of the playButton, then move another to the right side of the application. Double-click
the button to the right of the playButton to make it the active Canvas, and remove the
Paths. This will be the stop button. Draw a Rectangle with a Width of 14 and Height of
18. Set the RadiusX and RadiusY to 2 in the Appearance inspector, then set the Fill to solid
white and the Stroke to No Brush. Finally, set the Name of the Canvas to stopButton.

Double-click the button at the far right of the application to make. it the active
Canvas, and remove the Paths. This will be the full-screen button that will enable the user
to toggle between a full-screen view and a browser window view of the application. Draw
a Rectangle with a Width and-Height of 22. Set the RadiusX, RadiusY and StrokeThickness
to 2, the Fill to No Brush, and the Stroke to solid white. Then, draw a second Rectangle
with a Width and Height of 10, starting at the bottom-left of the previous Rectangle. Give
this Rectangle the same StrokeThickness and Fill and Stroke colors as the larger Rect-
angle. Finally, name this Canvas fullscreenButton.

Double-click the button that is still on top of the playButton to make it the active
Canvas, and remove the Paths, This will be the pause button. Draw two vertical paths
with the same properties as the paths in the play burton, and space them apart by a few
pixels. Name this Canvas pauseButton and set its Visibility attribute to Collapsed (i.c.,
hidden). We'll programmatically display this butron when it is needed.

The application displays the current time of the video in Ab:mms:ss format in the time-
Text TextBlock, located inside the timeCanvas Canvas. To create this element, first create
a Canvas named timeCanvas to the left of the full-screen button, and give it 2 Width of 75
and Haight of 23. Inside this Canvas, create 2 Rectangle that takes up the entire Canvas.
Set this Rectangle’s RadiusX and RadiusY to 2, and its StrokeThickness to 1. Set the Stroke
color to solid black, and the Fill 10 2 gradient going from grey to white. Create a TextBlock
named timeText using the TextBlock tool, and set its initial text value to "00:00:00". Use
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the default font (Lucida Sans Unicode) and font size (14.667). This TextB1 ock’s text value
will be updated programmatically in our JavaScript code-behind file.

Creating the Volume and Timeline Controls .

The application allows the user ro select the volume level through a volume control. To cre-
. ate this contro}, first create a Canvas named volumeCanvas with a Width of 15 and a Height
0f 30 to the right of the full-screen button. Use the Rectangle tool to creare a vertical Rect-
angle (the slider). Give the Rectangle a Width of 4 and Height of 30. Set the Fill of the Rect-
angle to light grey. Set the Stroke of the Rectangle to black, with a StrokeThickness of 1.

Use the Rectangle tool to create a horizontal Rectangle (to mark the current volume).
Give the Rectangle a Width of 14 and Height of 2. Set its Fill to white, its Stroke ro No Brush
and its Opacity to 50% (in the Appearance inspector). Center the horizontal Rectangle on
the center of the vertical Rectangle. Finally, name the horizontal Rectangle voTumeHead
and the Canvas volumeCanvas.

Next, we create a video timeline that serves two purposes. The timeline acts as a
progress bar while the video is being downloaded. This is accomplished by having a dark
grey Rectangle with a Width of 400 located underneath a light grey Rectangle with an
initial Width of 0. The light Rectangle’s Width is set programmatically in the JavaScript
code-behind file to indicate the download progress. Also, a vertical Rectangle acts as the
playhead, indicating the current playback progress of the video. To create the video time-
line, fiest create a Canvas named timelineCanvas to the right of the stop button, Give this
Canvas 2 Width of 400 and a Height of 20, and a Cursor of Hand. Inside this Canvas, create
a Rectangle named timelineRectangle with a Width of 400 and a Height of 4. Set its
StrokeThickness to 1, its Fill to dark grey and its Stroke to black. Center the Rectangle
vertically, then copy and paste the Rectangle. Name the copy downloadProgress-
Rectangle, set its Fill to a lighter grey and set its Width to 0. Note that because download-
ProgressRectangle appears after the timelineRectangle in the Objects and Timeline
inspector, it appears on top of the timelineRectangle. You can also specify the z-order
of elements {discussed in Section 5.6) using an object’s ZIndex ateribute. Higher ZIndex
integer values position the element closer to the foreground and in front of other elements
with smaller ZIndex values.

Create a Rectangle named playHead with a Width of 2 and a Height of 20. Place this
Rectangle at the far left of the Canvas and center it vertically. Set this Rectangle’s Fill to
No brugh, its StrokeThickness to 1, its Stroke to white, and its Opacity to 50%.

Using a MediaElement to Display Audiol Video
The MediaElesent allows you to include video and/or audio in your Silverlight applica-
tion. It supports WMV/VC-1 (including high-definition video), WMA and MP3 fo-
rmats. , :
First, create a Canvas named movieViewCanvas and set its Height to 260 and Width to
640. Inside the Canvas, add a MediaElement named movieMediaElement. To access the
MediaElement tool, click the Asset Library button (Fig. 19.3), check Show All and select
MediaEiement (Fig. 19.10). Set the MediaElement’s Width and Height to those of the
Canvas. Set the Source attribute to point to bailey.wnv in the Media inspector. )
This Canvas also contains a Play button overlaid on the video. First, create a Canvas
named playOverlayCanvas with an Opacity of 60%, a Width of 200 and a Height of 180.
Inside this Canvas, create a Rectangie with the same Width and Height as the Canvas, a Fill
of black, a Stroke of No brush, and a RadiusX and RadiusY of 40. Create an E171pse using
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the Ellipse tool with a Width of 100 and a Height of 100. Set its Filt to No brush, its Stroke
to white, and its StrokeThickness 1o 6. In the middle of this E11ipse, draw two Paths in
the shape of a right arrow, both with a Width and Height of 30, a StrokeThickness of 6, and
a StrokeStartlineCap and StrokeEndLineCap of Round. Underneath the E11ipse, create a
TextBlock containing the text Play. Set the font size to 36 in the Text inspector.

Finally, set the playOverlayCanvas Visibility atcribute to Collapsed, since we will
show this Canvas programmarically.

Creating Event Handlers in XAMIL

Expression Blend 2 August Preview does not currently have a user interface to set event
handlers, so we will manually set them in Scene.xaml (Fig. 19.12). The timelineTimer
Storyboard’s Completed attribute (line 8) registers an event that calls the updateTime
function located in our JavaScript code-behind file (Fig. 19.13) when the animation has
completed. This JavaScript function updates user-interface elements such as the timeline
marker.

Fig. 19.12 | Movie Viewer user interface described in XAML. (Part | of 5.)
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Fig. 19.12 | Movie Viewer user interface described in XAML. (Part 2 of 5.)
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Fig. 19.12 | Movie Viewer user interface described in XAML. (Part 3 of 5.)
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Fig. 19.12 | Movie Viewer user interface described in XAML. (Part 4 of 5.)
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Fig. 19.12 | Movie Viewer user interface described in XAML. (Part 5 of 5.)
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Configuring the Event Handlers

Fot each of the thumbnail bumon Canvases (crazyDogButton, gravityButton,
apo11615Button and f35Button), we specify a MouseLeftButtonDown attribute (lines 36,
44, 53 and 61, respecrively). This registers the movieThumbHandler function (Fig. 19.13,
lines 157—178) as the event handler to call when the user clicks one of these Canvases with
the left mouse button. Each of the playback control buttons also has a MouseLeftButton-
Down attribute (lines 71, 139, 163, 185 and 207 for the play, pause, full-screen, stop, play
overlay buttons, respectively). Each of these burtons has a separate event handler function.

The volumeCanvas has a MouseleftButtonDown attribute (line 118) that allows the
user to change the volume by calling volumeHand1er (Fig. 19.13, lines 239-245) when the
user clicks somewhere on the volumeCanvas. ‘

The downtoadProgressRectangle has a MouseleftButtonDown attribute (line 132)
that allows the user to jump anywhere in the video by calling the timelineHandler func-
tion (lines 225-236, Fig. 19.13) when the user clicks somewhere on the downloadPro-
gressRectangle.

The movieMediaElement’s MediaOpened attribute (line 205) is set to movieQpened-
Handler. When a new video is opened, function movieOpenedHandter (Fig. 19.13, lines
137-143) is called to ensure that the Play overlay button is visible, and to start the timer
thart keeps the timeline and time up to date. When you open a movie the MediaElement
begins playing the movie by default. We don’t want this to happen until the user clicks the
play button, so we set its AutoPlay attribute to false {line 204). The movieMediaEle-
ment’s MediaEnded attribute (line 204) is set 1o movieEndedHandler, When the video fin-
ishes playing, the movieEndedHandler function (Fig. 19.13, lines 146-155) is called to
“reset the video to the beginning and to ensure that the Play overlay button is visible.

Registering Event Handlers in JavaScript

An alternative to registering event handlers in the XAML is to register event handlers in
the JavaScript code. While this technique requires a few more lines of code, it has two key
advantages. First, it keeps the application’s logic (in this case, event handling) separate
from the application’s user interface. Second, it allows you to add and remove event lis-
teners dynamically. The JavaScript for adding an event handler is:

variableName = objectName . addEventHandler( " EventName", eventHandler };

The JavaScript for removing an event handler is:

objectName . removeEventHandler( "EventName", variableName ) ;

When an event is registered in JavaScript using the addEventt.istener method, we must
assign the return value of the method to a variable. This way, if we wish to remove an event
listener using the removeEventListener, we can remove only that specific event listener.

l9.4.4Using}]avaScript for Event Handling and DOM Manipulation

The JavaScript code-behind file, Page. xam1.3s (Fig. 19.13), defines the event handlers for
the various elements in the XAML. In the event handlers, we use JavaScript to manipulate
the Silverlight DOM, similar to how we manipulared the XHTML DOM in Chapter 12
and the XML DOM in Chapter 14. To edit the JavaScript code files, use your preferred
text editor. .
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Fig. 19.13 § JavaScript code-behind fi

e for Movie Viewes. (Part | of 6.)
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Fig. 19.13 | JavaScript code-behind file for Movie Viewer. {Part Z af 6.)
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Fig. 19.13 | JavaScript code-behind file for Movie Viewer, (Part 3 of 6.)
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S
ost.content.fullScreen =

105

Fig. 19.13 | JavaScript code-behind file for Movie Viewer. (Part 4 of 6.)
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Fig. 19.13 | JavaScript code-behind file for Movie Viewer. (Part 5 of 6.)
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Fig. 19.13 | JavaScript code-behind file for Movie Viewer. (Part 6 of 6.)

Handling Fvents and Accessing XAML Elements in JavaScript

Lines 5~27 declare variables that our event handler functions use to access the XAML
elements in our video player. In the canvasLoaded function (lines 29-60), which handles
the Page Canvas’s Loaded event (Fig. 19.12, line 6), these variables are set to reference
their corresponding XAML elements using the sender’s findName method (lines 33-53).
Every event handler receives sender and eventArgs parameters. The sender parameter is
a reference to the element with which the user interacted, and the eventArgs parameter
passes information abous the event that occurred. Line 32 sets the host variable to the Sil-
verlight plug-in object using the getHost method. This allows us to access properties of
the Silverlight plug-in, such as its screen dimensions, throughout the program. Line 56
registers an event handler for the plug-in’s onFul1ScreenChange event. Line 59 calls the
timelineTimer Storyboard’s begin function, to start the Storyboard that we are using as
a timer. When this Storyboard’s Completed event (Fig. 19.12, line 8) occurs—i.e., its 0.1-
second-long animation completes (Fig. 19.12, lines 9-14)—the event handler update-
Time (lines 63~100) is invoked.

Creating a Timer

The updateTime function (lines 63--100) updates the timeText, the downloadProgress-
Rectangle, the playHead, and starts the time1ineTimer again if necessary. It uses the con-
vertToHHMMSS function (lines 249-273) to convert the movieMediaElement’s posi-
tion.Seconds—its elapsed time in seconds—to hours, minutes and seconds {lines
66~69), then displays that time in hb:mm:ss format in the timeText textBlock {line 72).
The updateTime function also updates the download progress indicator (lines 75-76) by
setting the width of the downloadProgressRectangle to the width of the timelineRect-
angle multiplied by the movieMediaE1ement’s downloadProgress, which is a value from
0 to 1 representing the fraction of the video thart has downloaded so far. Lines 8081 check
whether movieMediaElement’s naturalDuration and position.Seconds properties exist.
If they do, lines 83-85 sct the playHead’s position to the current playback position in the
video. This is accomplished by setting the playHead’s Canvas. Left attribute to the sum
of the timelineRectangle’s Canvas.Left ateribute and the width of the timelineRect-
angle multiplied by the ratio of current time (movieMediaElement.position.Seconds)
and total time (movieMediaElement.naturalDuration.Seconds). Left is a dependency
property of Canvas, meaning that the Left value is relative to that of the Canvas. Since
the Canvas . Left dependency property already has a dot in its notation, we must enclose
the attribute name in quotes and square brackets, as in element[ " artributeName" ] . If
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movieMediaElement’s naturalDuration and position.Seconds attributes do not exist,
line 91 sets the playHead’s Canvas . Left attribute to be equal to the timelineRectangle’s
to indicate that the movie has not started playing. Finally, lines 95-99 check whether the
download is not finished or the movie is playing, in which case it calls timelineTimer’s
begin function ro run the timer again. This way, the downloadProgressRectangle and
playHead will be updated.

Handling Button Events _

The playAndPauseButtonEventHandler function (lines 103—122) handles the play and
pause butrons’ MouseleftButtonDown events (Fig. 19.12, lines 71 and 139). Line 107
checks whether the movieMediaElement is currently playing. If it is, the video should be
paused and the play butron should be shown. If not, lines 116-120 play the video, start
the timelineTimer, show the pause button and hide the playOverlayCanvas.

The stopButtonEventHandler function (lines 125—134) handles the stop button. It
stops the video (line 127}, then shows the play button and the Play overlay button (lines
128-132). Finally, it calls the updateTime function to ensure that the timeText Text-
Block displays 00:00:00.

Function movieThumbHandler (lines 157—-178) handles the movie thumbnail burtons.
Lines 159-161 stop the video and show the play button. Lines 163—177 contain a switch
statement that checks the sender element’s name attribute {the name of the button that
was clicked) and sets the Source of movieMediaE1ement to the corresponding video file.

Adding a Full-Screen Feature
Function toggleFul1Screen (lines 181—184) handles the full-scréen button. Line 183 sets
the Silverlight plug-in’s ful1Screen attribute to the opposite of its previous value. This
means that if the plug-in was previously in full-screen mode, it will switch to windowed
mode, and if it was previously in windowed mode, it will switch to full-screen mode.
The onFul1ScreenChangeHandler funcrion (lines 208-216) handles the onFull-
ScreenChange event. Lines 190—191 uses the updateLayout function to update the layout
of the application based on'its current width and height. Then, line 194 calls the
updateTime function.

Dynamically Changing XAML Layout
Function updateLayout (lines 198-222) repositions the user interface elements relative to
the width and height parameters. Lines 201-202 set the width and height of the Page
Canvas to the width and height parameters. Lines 203-204 set the width and height of
movieMediaFlement to the width parameter and the height parameter minus 220 (feaving
room for the controls). Lines 205-208 move the movieMediaElement in the application.
Line 209 sets the width of the controls Canvas. Lines 210-213 center the playOverlay-
Canvas over the movieMediaElement. Lines 214-215 center the controls at the bottom of
the application. Line 216 sets the width of the timelineRectangle 1o be the width of the
controls Canvas minus 235, to allow room for the other controls. Lines 217-219 move
the full-screen button, timeCanvas and volumeCanvas to the right side of the controls
Canvas. Finally, lines 220-221 center titleText at the top of the application.

The movieOpenedHandler function (lines 137-143) handles movieMediaElement’s
MediaOpened event (Fig, 19.12, line 205). Line 139 starts the timelineTimer to update
the loading progress rectangle, and line 142 shows the playOverlayCanvas.
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The movieEndedHandler function {lines 146-155) handles the movieMediaEtement’s
MediaEnded event (Fig. 19.12, line 204). It stops the video (line 148), which resets the
playback position to the beginning, then shows the play burton and hides the pause button
(lines 149--150). Lines 153 shows the playOverlayCanvas. Finally, line 154 calls the
updateTime function to ensure that the timeText textBox displays 00:00:00.

Creating a Timeline for a MediaFElement

The timelineHandler function (lines 225-236) handles the downloadProgressRectan-
gle’s MouseLeftButtonDown event (Fig. 19.12, line 132). Lines 228-234 ser el apsedTime
to the position that was clicked on the timeline, convert the number of seconds to
bh:mm:ss format using the convertToHHMMSS function and ser the Position of the
movieMediaElement to that time string. Finally, line 235 calls the updateTime function
to show the new position.

Controlling Volume of a MediaElement

Function volumeHandler (lines 239-245) handles the volumeCanvas’s MouselLeftButton-
Down event (Fig. 19.12, line 118). Lines 241-242 set movieMediaElement’s volume prop-
erty based on the position the user clicked on the volumeCanvas. We convert the
y-coordinate of the mouse relative to the volume rectangle to a value between 0 and 1 (0
being muted and 1 being full volume). Lines 243--244 move the volumeHead to the new
position.

19.5 Embedding Silverlight in HTML

Expression Blend generates an HTML wrapper named Default.htm1 for your Silverlight
application when you first create the Silverlight project. Figure 19.14 shows a version of
this file that we formatted for readabiliry. You can open Default.htm1 in a supported web
browser to test your application. You can embed a Silverlight application into an existing
HTML file by including the scripts (lines 8-10), the silverlightHost style class (lines
12-13} and the SilvertightControlHost div (lines 17-21). You can adjust the width
and height of your application by changing the width and height attributes of the
silverlightHost style class (lines 12-13).

"text/ javascript” src
“text/javascript” src

Py

Fig. 19.14 | HTML wrapper for Movie Viewer. (Part | of 2.)
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§F 0 <div ig = "SilverlightControlHost! class = "silverlightHost®> .
8 .. ... <sCripl type = mrext/javascript™s B o T

19 oo createSitverlight(3;

2 L efscript> o

2 fdivs

r </body> ' _ :
23 </heml> e R e S s

Fig. 19.14 | HTML wrapper for Movie Viewer. (Part 2 of 2.)

The createsilveriight function (line 19) s located in Default_html.js
{Fig, 19.15). This function inserts the Silverlight plug-in object in the SilverlightCon-
trolHost div. The Default_htm1.js file that Expression Blend creates will not work with
our project because it tries to access funceion Page in the JavaScripr, which no Jonger
exists. You must remove the lines instantiating the scene variable and set the onLoad event
to nuil (line 15).

{7/ Fig. 19.15: Defaule_html.js 0 0 et o o
.27 ff-Credte Silverlight object in SilvertightControltost div.
4 funbrion createSitverlight(y TS S
" 4 : : o
5 5ilverlight.createObjectix( {
6 source: "Page.xaml", o . DRI Lo
7 ~ parentElement: dik‘:mer‘rt-.gétEi’émﬁtBYlﬁﬁ-:’Sﬂ;}aer’]f?i@t_tﬁdﬂﬁ?dmﬁ' 3y
8 | id: "SilverlightControl™, - - A [
9 © properties: { ' '
- " width: “100%",
1§ SR . height: "100%",
A2 - wersion: "1.07
14 events: {
f ) onboad: nult
16 1
17 )
18 1
A9

20 - if ( lwindow.Silverlight ).
21 window.Silverlight = {};

23 SilverTight ‘createDelegate =
24 . return function(y { CoLTTRERS T
28 oooTeturn method.apply( instance, argui

Fig. 19.15 | Creates Siiverlight object in 5ilver1i ghtControlHost div.

19.6 Silverlight Streaming

Microsoft provides a service called Silverlight Streaming at silverlight. Tive.com. This
service currently hosts vour Silverlight applications for free, which allows idividuals and
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businesses to share video content online without having to provide and pay for the signif-
icant bandwidth that video requires. While in prerelease status. Silverlight Streaming pro-
vides you with “up to 4GB storage and unlimited outbound streaming. and no limit on
the number of users that can view those streams.™ Eventually. Microsoft intends to allow
“up to 1 million minutes of free video streaming at 700 Kbps per site per month. Unlim-
ited streaming will also be available for free with advertising, or with payment of a nominal
fee for the service for use without advertising.”” You can easily embed Silverlight applica-
tions thar are hosted by this service into your web pages.

Encoding Your Video with Expression Media Encoder

According to dev.1ive.com/silverlight/, the bit rate of video files included with Sil-
verlight applications must not exceed 700 Kbps. To ensure that your video adheres to
these requirements, it is recommended that you encode vour video using Microsoft Exp-
ression Blend Media Encoder. A free trial of Mcdia Encoder is available at
waww.microsoft.com/expression/products/downtoad. aspx?key=encoder. Once Media
Encoder is installed, open it and select Import... from the File menu. Select the video file
you would like to encode (Media Encoder supports many video types) and click Open. It
the video is encoded in VC-1 and doesn’t open properly, you may need to install Windows
Media Player 11. In the Profile panel of the Settings inspector {Fig. 19.16). you can select
the Video and Audio type. For the Movie Viewer example. we encoded the video using VC-
1 Streaming Broadband and the audio using the Default Profile. In the Qutput inspector
(Fig. 19.16}, you can have Media Encoder save a thumbnail of a frame of vour choosing,
and have the ourput include one of 14 prebuile Silverlight media player templates for your
video. To start the encoding process, either select Encode from the File menu, or click the
Encode button at the bottom of the Media Content inspector.

Uploading an Application to the Silverlight Streaming Service

To use the Silverlight Streaming service, you must go to silveriigiat. live. comand regis-
ter for an account. Once you have an account. log in and sclect Manage Applications from
the navigation links on the left side of the page. This page will show vou whar applications
are currently being hosted on your account, and it also enables you to upload applications.

Fig. 19.16 | Microsoft's Expression Media Encoder. (Part | of 2.)

1. dev.live.com/terms/
2. dev.live.com/silverlight/
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Fig. 19.16 | Microsoft’s Expression Media Encoder. (Part 2 of 2.)

To upload an application, you must package it into a Zip archive. This archive must
contain your XAML, your code-behind file, any media elements you use in the applica-
tion, and a manifest.xm1 file (Fig. 19.17). The manifest.xm1 file specifies the filename
of your XAML file (line 4), width and height (lines 5-6), and more.

Fig. 19.17 | Manifest for Movie Viewer on Silverlight Streaming.
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On the Manage Applications page, click the Upload a Silverlight Application link. You
must enter an Application Name and sclect the Zip archive you wish to upload. If the appli-
cation uploads successfully after you click Upload, you will see the Manage Application
page for the application. On this page, Microsoft provides instructions for adding the
application to an existing web page. First, you must create a new JavaScripr file to handle
the CreateSilverlight function that adds the Silverlight application inside a div in your
HTML. For the div element that you add to your HTML, make sure to set the width and
height parameters to the width and height of your application. Figures 19.18 and 19.19
show the HTML and JavaScript needed to embed the Movie Viewer application that is
hosted on Silverlight Screaming,

g

<scr1pt type =: text/]a:vascnpt
_src = "CreateSilverli ht . j

O I T

Fig. 19.19 | JavaScrlpt to add the Silverlig it object to Wrapper_Mow eViewer div.
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19.7 Silverlight 1.1 Installation and Overview

Silverlight 1.1 uses a lightweight version of the NET CLR (Common Language Run-
time) in the browser plug-in. This allows you to program Silverlight applications in C#,
Visual Basic, Python, Ruby and lavaScript. Silverlight 1.1 applications use the NET
CLR'’s just-in-time (JIT)} compiler ro compile the code to machine language, allowing for
a significant improvement in performance over the interpreted JavaScript used in Silver-
light 1.0 and Ajax.

To install the Silverlight 1.1 Alpha Refresh browser plug-in, go to silverlight.net/
GetStarted/ and download the Silverlight 1.1 Alpha Refresh runtime for your platform.
Once you have installed it, you can see some 1.1 applications in action at the website
silverlight.net/themes/siiverTight/community/gallerydetail.aspx?cat=2.

A chess game that serves as an excellent demonstration of the performance improve-
ment is located at silverlight.net/samples/1.1/chess/run/default.html. This game
allows you to compare the performance of a computer player coded in .NET to the per-
formance of a computer player coded in JavaScript. As you will see, the NET player usu-
ally wins because it can analyze many more moves than the JavaScript plaver in the same
amount of time. :

We will develop our Silverlight 1.1 applications using Microsoft Expression Blend 2
and Microsoft Visual Studio 2008. Afier you have installed these rools, download and
install the Silveright Tools Alpha for Visual Studio from go.microsoft.com/fwiink/
7LinkID=89149&c1cid=0x409. Now, you can create a Silverlight 1.1 Alpha Refresh
project.

19.8 Creating a Cover Viewer for Silverlight 1.1 Alpha

Our next example is a Deitel book cover viewer (Fig. 19.20) written in XAML
(Fig. 19.21) with a Visual Basic code-behind file (Fig, 19.22) for Silverlight 1.1 Alpha
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Fig. 19.20 | Deitel book-cover viewer running on Silvertight 1.1 Alpha Refresh. (Part 2 of 2.)

Refresh. This cover viewer retrieves an RSS feed containing the image URIs, and displays
three covers at a time. Clicking the cover on the left or right triggers an animation that
moves the cover the user clicked to the center. You can test a live version of this application
ar test.deitel.com/exampies/iw3htp4/silverlight/Coverviewer/index.html.

Creating a Silverlight 1.1 Application in Visual Studio 2008 _
To create a Sitverlight 1.1 Alpha Refresh project, open Visual Studio 2008 and select New

Project in the File menu. Next, select Visual Basic (for your later projects, you can also .
select Visual C#), then Silveright, then specify the name and location of your project, and
click OK. The project will initially contain a XAML file, Page.xam1, a code-behind file,
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Page.xam).vb, Silverlight. js and the HTML wrapper, TestPage . htmi. You can work
on this project in both Visual Studio and Expression Blend at the same time. When you
make a change in one program, then switch to the other, it will alert you that the file has
been modified outside the program and prompt you to reload the file. Select Yes to ensure
that you include any changes you made in the other program.

At line 7 of Page.xam1 (Fig. 19.21), we define the x:Class attribute, which specifies
the Class that contains our event handlers, in this case the Page class in Page.xaml1.vb
{lines 9-159 of Fig. 19.22). The GUI conrains two TextBlocks—titleTextBlock (lines
230-233) and errorTextBlock (lines 234-236)—and three Images—prevImage (lines
237-248), currentImage (lines 249-250) and nextImage (lines 251-262). Both next-
Image and prevImage have a MouseLeftButtonDown attribute, registering the event han-
dlers for this event.

Fig. 19.21 | Deitel Cover Viewer in Silverlight 1.1 Alph
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Fig. 19.21 | Deitel Cover Viewer in Silverlight |.1 Alpha Refresh. (Part 2 of 2.)

In lines 10-100 (of which lines 12-99 are not shown to save space), the next-
ImageAnimation Storyboard moves and resizes the three images so that the nextImage
replaces the currentImage, the currentImage replaces the prevImage, and the prevImage
disappears. This animation code was generated using Expression Blend. To create this ani-
mation, first click the Croate new Storyboard button (Fig. 19.4). Name the Storyboard
nextImageAnimation, and sclect the Create as a Resource checkbox. Then, select next-
Image and click Record Keyframe. Move the time slider to 0.5 seconds, then move and
resize the element so that it replaces currentImage. You can click the Play button to see a
preview of the animation.

Storyboard nextImageAnimation has a Completed ateribute (line 11} that specifies
the event handler to be called when the animation is complete. In lines 101-227 (of which
lines 103226 are not shown to save space), the prevImageAnimation Storyboard moves
and resizes the three images so that the prevImage replaces the currentImage, the
currentImage replaces the nextImage, and the nextImage disappears. This animation also
has a Completed artribute (line 102) that specifies the event handler to be called when the
animation is complete.

Visual Basic Code-Behind File

The Visual Basic code-behind file, Page.xam1.vb (Fig. 19.22), begins by importing the
class libraries the application will use (lines 3—7). Lines 9-10 specify thar the Page class
Inherits methods and properties from the Canvas class. Lines 13—15 declare the instance
variables the application will use. These include imageURIArrayList (a List of the image
Uris), currentImageIndex {which holds the index number of the Uri in imageURIArray-
List to be displayed as the currentImage), and appRootURI (which uses the appRootURI-
Gen method (lines 151-158) to find the root URI of the application at runtime}.
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Create Arrayhst of UREs:
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Fig. 19.22 | VB code behind f|le for(‘over Vuewer (Part | of3 )
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“AmagetRTArraylist.Add( _
_New Uri(currentImageURI))
Y w,ﬁg%%

x%cur':"t-:nthla:ge.Sou_r'cse = imageURIArrayList(currentlmageindex)
Source = imageURTArraylistcurrentImageIndex + 1)
e o e e i e
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extimage
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Fig. 19.22 | VB code-behind file for Cover Viewer. {Part 2 of 3.)
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WWM”F:’Q"E}@‘% AL A R
previmageAnimation.Stop{

im path = HtmlPage.BocumentUri.AbsolutePath

im lastSlash = path.lLastIndexOf("/") -+ - .

ath = path,Substring(0, YTastSlash + 1) | .
eturn "htip://" & HtmlPage.Documentlri.Host -& patf

Fig. 19.22 | VB code-behind file for Cover Viewer. (Part 3 of 3.)



Microsoft Silverlight™ and Rich Internet Applications 775

In method Page_Loaded (lines 17-78), line 19 inirializes the application using the
InitializeComponent method located in the autogenerated Page.g. vb file (located in the
obj\Debug directory). This file takes any XAML elements that have an x:Name attribute,
and uses the FindName method to map each element 10 a variable of the same name. This
means that we do not have to do this manually, as we did for the Silverlight 1.0 Movie
Viewar example. It also allows us to use Visual Studio’s IntelliSense feature to autocom-
plete XAML element names in our code-behind file.

Lines 2077 try to download an RSS file, bookCoversrss.xml (Fig. 19.23), and
create an array of image Uris. First, lines 2123 crearc a BrowserHttpWebRequest object
that downloads the RSS file located at the URI created by concatenating the appRootURI
variable with bookCoversRSs . xm1. Note that the BrowserHttpwebRequest object does not
currently support cross-domain requests, so the application and the RSS file must be
located on the same server. Lines 26 and 29 get the object used to manipulate the request’s
response, then get the stream associated with that object. Lines 34-35 create an XmlReader
object to parse the RSS content. The Xm1Reader class provides read-only access to the ele-
ments in an XML document. Lines 38--65 contain a While loop in which the condition
remnains True until the XmiReader has reached the end of the RSS. Lines 4142 search for
an item element in the RSS, and lines 45-53 read the contents of that element and search
for an image element inside the item clement. Upon finding an image element, lines 56—
59 add the contents of the image clement (the image’s filename) to the imageURIArray-
List as a complete Uri including the application’s root Uri (appRootURI). Line 69 closes
the BrowserHttpWebReguest. Lines 72-73 set the Source attribute of the currentImage
and nextImage to the first and second elements of the jmageURIArrayList. Lines 75-76
catch any exceptions and display the error message in the errorTextBlock.

Fig. 19.23 | RSS for Deitel book-cover viewer. (Part | of 2.)
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Fig. 19.23 | RSS for Deitel book-caver viewer. (Part 2 of 2.)

Method appRootURIGen (Fig, 19.22, lines 151-158) first uses the Htm1Page clement
to find the AbsolutePath of the page. Lines 155-156 find the last forward slash (/) of the
Uri and save the Uri up to that last slash as a string, using the Substring method. Line
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157 returns a string concatenating "http://", the Silverlight application’s Host (the
domain name or IP address of the server) and the path string.

Method nextImageHandler {lines 129—136) handles nextImage’s MouselLeftButton-
Down event. Line 133 checks whether there are, in fact, additional book covers to the right.
If so, line 134 begins the nextImageAnimation Storyboard. Upon completion, this
Storyboard will call the nextImageSwitch method (lines 81-102}. Line 86 checks
whether there is only one more book cover to the right, in which case it will increment the
currentImageIndex by one (line 87), update the Source of prevImage and currentImage
{(90-91), and hide nextImage (line 92). If there is more than one book cover to the right,
lines 94—100 will increment the currentImageIndex by one (line 94), update the Source
of all three Images (lines 97-99), and ensure that previmage is visible (line 100}, in case
the user is going from the first book cover (where prevImage would be hidden) to the
second book cover. Methods prevImageHandler (lines 139148} and prevImageSwitch
(lines 105-126) provide the corresponding functionality for prevImage,

19.9 Building an Application with Third-Party Controls

Though Silverlight 1.1 Alpha Refresh does not yet include pre-built controls, a number of
third-party control libraries have been created. One such third-party library is Netika’s
GOA WinForms library for Silverlight. This library is an implementation of .NET's Sys-
tem.Windows . Form library for both Silverlight and Flash. This allows us to create Silver-
light applications by using .NET deskeop applications as templates. The free version of
GOA WinForms includes 40+ controls, including buttons, text boxes, calendars and
more. Netika’s website at waw. netikatech. com includes demos and documentation for alt
the controls. To download the library, go to www.netikatech.com/downloads and select
the standard Silverlight version of GOA WinForms. After installation, open Visual Srudio
2008 and creare a new project. Select Visual Basic, then GOA WinForms VB Application in
My Templates. Name this project InterestRateCalculator, as we will be creating a Silverlight
application that calculates interest. For a GOA WinForms project, the Visual Basic code-
behind file is located in MyForm.vb. In this file, you will find an InitializeComponent
function (lines 27-42) that creates a Button. Select Build InterestRateCalculator from the
Build menu, then open TestPage.htm1 in your browser to see a sample button.

Open up the InterestRateCalculatorForWindows project from the examples direc-
tory. We are going to be creating a Silverlight application from this deskrop application
(Fig. 19.24). First, build and run the project to see how the application looks on the
desktop. Next, replace the InitializeComponent funcrion in the InterestRateCalcu-
lator project’s MyForm. vb with the InitializeComponent in the InterestRateCalcula-
torForWindows project’s InterestRateCalculatorForWindows.Designer.vb, Then
replace the Friend WithEvents line (line 26) in the InterestRateCalculator project’s
MyForm.vb with the Friend WithEvents lines (lines 139-147) in the InterestRateCa-
JculatorForWindows project’s InterestRateCalculatorForWindows.Designer.vb file.
Finally, copy the btnCalculate_Click function from the InterestRateCalculatorFor-
Windows project’s InterestRateCalculatorForWindows.vb into the MyForm class in the
InterestRateCalculator project's MyForm.vb.

Try to build the InterestRateCalculator project. You will see several errors. This is
because not every property of the Windows Form controls has been implemented in GOA
WinForms. Looking at Fig. 19.25, you will see thar we commented out lines 47, 60, 82,
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Amount o Deposit
$1,050.00
$3,102.%0
$1,157.63
§1,215.53
$2,276.28

Fig. 19.24 | Interest Calculator in Windows and Silverlight

100, 118 and 128-129. These lines all accessed properties not supported in GOA Win-
Forms. We kept these lines as comments to show you the relatively easy process of con-
verting a Visual Basic deskrop application to a Silverlight 1.1 application when using GOA
WinForms controls.

Fig. 19.25 | Using third-party controls in Silverlight 1.1 Alpha Refresh. (Part | of 5.)
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Fig. 19.25 | Using third-party controls in Silverlight 1.1 Alpha Refresh. (Part 2 of 5.)
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Fig. 19.25 | Using third-party controls in Silverlight i.1 Alpha Refresh. (Part 3 of 5.)
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Fig. 19.25 | Using third-party controls in Silverlight 1.1 Alpha Refresh. (Part 4 of 5.)
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SRR EHRER

amount = principal * Convert. ToDet'lma'I(
Math.Pow(l + rate / 100, yearCounter))
. extDisplay.Text & Strmg Format{ {G -3 D}{l C}" & vbCrLF,

yeaernter amorznt)

Fig. 19.25 | Using third-party controls in Sitverlight 1.1 Alpha Refresh. (Part 5 of 5.)

Build the InterestRateCalculator project, then open up TestPage.html in a web
browser. You will see an "AG_E_UNKNOWN_ERROR" error message because the applica-
tion is not running from a web server. You can safely ignore this error message for now. Test
the application, and compare it with the desktop version (Fig. 19.24). Some of the con-
trols function slightly differently, as GOA WinForms is not an exact replica of the stan-
dard Windows Forms controls.

The InitializeComponent function (lines 23-146) was generated in the Interest-
RateCalculatorForWindows project using Visual Studio’s design mode. TextBoxes are
used to input the principal and interest-rate amounts, and a Numeri cUpDown control is used
to input the number of years for which we want to calculate interest.

The btnCalculate_Click function (lines 162—183) handles btnCalculate’s Click
event (line 163). Lines 165 and 168 declare two Decimal variables, principal and amount.
Line 166 declares rate as type Double, and line 167 declares year as type Integer. Lines
170-171 take the Text from the txtPrincipal and txtInterest text boxes, convert them
to the correct type, then store the value in the corresponding variable. Line 172 takes the
Value from the updYear NumericUpDown, converts it to an integer, and stores the value to.
year. Lines 174-175 set the txtDisplay’s Text to display "Year" and "Amount on
Deposit” column headers followed by a carriage return. These are formatted using the
String.Format method.

Lines 177~182 count from 1 to year in increments of 1. Lines 178—-179 perform a
calculation based on the following formula:

a=p(l+n"

where  is the amount, p is the principal, r is the rate and » is the year, Lines 180-181
set txtDisplay’s Text to display two columns containing the current yearCounter and
amount values.

19.10 Consuming a Web Service

In the next example, we consume a web service from a Silverlight application. The web
service is designed to perform calculations with integers that contain a maximum of 100
digits. Most programming languages cannot easily perform caleulations using integers this
large. The web service provides client applications with methods that take two “huge
integers” and determine their sum, their difference, which one is larger or smaller and
whether the two numbers are equal. We've placed the web service is on our website at
test.deitel.com/hugeinteger/hugeinteger.asmx.
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We provide a Visual Basic program that consumes this web service. We will create a
Silverlight application using that application’s code, then we'll add a proxy class to the
project that allows the Silverlight application to access the web service. The proxy class (or
proxy) is generated from the web service’s WSDL file and enables the client to call web
methods over the Internet. The proxy class handles all the details of communicating with
the web service. The proxy class is hidden from you by default—you can view it in the
Solution Explorer by clicking the Show Al Files button. The proxy class’s purpose is to
make clients think that they are calling the web methods directly.

When you add a web reference to the Silverlight project, Visual Studio will generate
the appropriate proxy class. You will then create an instance of the proxy class and use it
to call the web service’s methods. First, create a new GOA WinForms VB Application named
HugeInteger in Visual Studio 2008, then perform the following steps:

Step 1: Opening the Add Web Reference Dialog
Right click the project name in the Solution Explorer and select Add Web Reference...
(Fig. 19.26).

Step 2: Locating Web Services on Your Computer

In the Add Web Reference dialog that appears (lig. 19.26), enter http://
test.deitel.com/hugeinteger/hugeinteger.asmx in the URL field and press Go. You
will see a list of the operations that the HugeInteger web service provides. Note that for
the application to work, it must reside on the same server as the web service, because Sil-
verlight 1.1 does not yet allow for cross-domain requests. These steps demonstrate the pro-
cess we went through to create the application on our server at test.deitel .com/exam-
ples/iw3htp4/silverli ght/HugeInteger/,

Step 3: Adding the Web Reference
Add the web reference by clicking the Add Reference button (Fig. 19.27).
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gelnteger
The following cperations ars supported. For a format defintion,

Adid
Adds two huge integers,

Bigger
Determines whether the first integer is larger than the
second integer.

EauniTo
Detarmines whether the first intager is squa to the sacond
integer.

Smaller
Determines whathar the first integer is smaller than the
smcand integer.

+ Subtract

Fig. 19.27 | Web reference selection and description.

Step 4: Viewing the Web Reference in the Solution Explorer

The Solution Explorer (Fig. 19.28) should now contain a Web References folder with a
node named after the domain name where the web service is located. In this case, the name
is com.deitel. test because we are using a web service from test.deitel.com. When we
reference class HugeInteger in the client application, we will do so through the com.
deitel.test namespace.

Fig. 19.28 | Solution Explorer after adding a web reference to a project.
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19.10.1 Consuming the HugeInteger Web Service

Now, copy the InitializeComponent function (lines 14-109) and Private WithEvents
section (lines 111-119) from HugeIntegerForWindows.Designer.vb in the HugeInte-
gerForWindows project to MyForm.vb in the HugeInteger project. Delete the old Initial-
jzeComponent function and Friend WithEvents line in MyForm.vb. Then, copy lines 6~
117 from HugeIntegerForWindows.vb in the HugeIntegerForWindows project into the
MyForm Class located in MyForm.vb in the HugeInteger projecr. If you try to build the
project now, you will notice that the code is trying to access properties not supported by
GOA WinForms. In Fig. 19.29, we commented out lines 3841, 85-86, 95-95, 105-107
and 118-119 to remove statements that access unsupported properties in GOA Win-
Forms. If you were running this application from the same server as the web service, you
could now build this application and run it by opening TestPage.html. Try the compl-
eted application at test.deitel.com/examples/iw3htp4/silverlight/Hugelnteger/.

Fig. 19.29 | Consuming the HugeInteger web service in Silverlight 1.} Alpha. (Part 1 of 6.)
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Fig. 19.29 | Consuming the HugeInteger web service in Silvertight 1.1 Alpha. (Part 2 of 6.)
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Fig. 19.29 | Consuming the HugeInteger web service in Silverlight 1.1 Alpha. (Part 3 of 6.}
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Fig. 19.29 | Consuming the HugeInteger web service in Silverlight |.1 Alpha. (Part 4 of 6.)
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Fig. 19.29 | Consuming the HugeInteger web service in Silverlight i.1 Alpha. (Part 5 of 6.)
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Fig. 19.29 | Consuming the HugeInteger web service in Silverlight 1.1 Alpha. (Part 6 of 6.)

The code in Fig. 19.29 uses the HugeInteger web service to perform compurtations
with positive integers up to 100 digits long. You are already familiar with converting a
Visual Basic Windows Forms application to Silverlight, so we focus our discussion on the
web services concepts in this example,

Line 151 creates variable remoteInteger and initializes it with a proxy object of type
com.deitel.test.HugeInteger. This variable is used in each of the application’s event
handlers to call methods of the HugeInteger web service. Lines 171-172, 183-184, 207,
224 and 240 in the various button event handlers invoke methods of the web service. Note
that each call is made on the local proxy object, which then communicates with the web
service on the client’s behalf.

The user inputs two integers, each up to 100 digits long. Clicking a button causes the
application to invoke a web method to perform the appropriate task and return the result.
Note that client application HugeInteger cannot perform operations using 100-digit
numbers directly. Instead the application creates String representations of these numbers
and passes them as arguments to web methods that handle such tasks for the client. It then
uses the return value of each operation to display an appropriate message.

Note thar the application climinates leading zeros in the numbers before displaying
them by calling String method TrimStart, which removes all occurrences of characters
specified by a Char array (line 154) from the beginning of a String.

19.11 Silverlight Demos, Games and Web Resources

In this section we provide links to, and descriptions of, several websites where you’ll find
Silverlight demos, games, controls, sample code and tutorials. For additional Silverlight
resources (including tutorials, articles, blogs, books, sample chapters, communiry sites,
FAQs, RSS feeds, podcasts, videos and more), visit the Deitel Silverlight Resource Center
at www.deitel.com/silverlight.

siltverlight.net/community/communitygallery.aspx

The Silverlight Gallery provides a large collection of Silverlight 1.0 and 1.1 sample applications.
Check cut the top-rated and recently added samples, or view the complete list. Each sample includes
a star rating, a description and options for viewing and downloading the samples. Become a member
to upload and share your Silverlight applications with the community.
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www . hanselman.com/blog/SilverlightSamples.aspx
A collection of Silverlight sample applications (many overlap with Microsoft’s Silverlight Gallery)
compiled by Scort Hanselman, a Microsoft MVP.

community.netikatech.com/demos/

GOA WinForms demos from Netika Tech, available for Silverlight and Flash. GOA WinForms is
an implementation of the .NET System.Windows.Form library in Silverlight and Flash for devel-
oping RIAs. The simple demos include quick tours of GOA WinForms controls, a DataGrid, an
Outlook-like calendar and a Visual Studio-like form designer.

www . andybeaulieu. com/Home/tabi d/67/EntryID/73/Default.aspx

Silverlight Rocks! is a simple shooter game built with Silverlight 1.1. Using four buttons on your
keyboard, you can turn the spaceship left or right, shoot and thrust forward. The goal is to destroy
the asteroids. The author provides a walkthrough of how he wrote the game. The source code is
available for download.

www . andybeaulieu.com/Home/tabi d/67/EntryID/75/Default.aspx

Destroy All Invaders is a shooter game built with Silverlight 1.1. Select a location from the drop-
down list (options include rural upstate New York, Microsoft’s Redmond campus and Las Vegas, o
name a few) or enter a specific address. The game brings up a satellite image of the location and an
animated helicopter. The point of the game is to shoot and destroy the UFOs, The author provides
a walkthrough of how he wrote the game. The source code is available for download.

www .bluerosegames . com/brg/drpopper/default.html

Dr. Popper Silverlight Edition by Bill Reiss of Blue Rose Games is written for Sitverlight 1.1. The
game consists of multiple colored bubbles arranged ona 10-bubble by 8-bubble board. You can rem-
ove the bubbles in groups of two ot more, gaining more points for bigger groups. The source code
is available for download.

www . ai5to. com/Roeder/Silverlight/Monotone/Default.aspx
Monotone is an animated graphics demo built for Silveright {using C#) and MP3 audic. Download
the source code at www.aisto.com/Roeder/Silverlight/.

www.ajsto.com/Roeder/Silveriight/Inplay/Default.aspx

InPlay is an in-browser audio and video player. The demo includes stunning audio and video, and
you can use the controls to adjust the volume and position. Source code for InPlay is available at
www.aisto.com/Roeder/Silverlight/.

zeragravity.terralever.com/

Zeto Gravity is an adventure game, created by Terralever using Sitverlight and C#. The game fea-
tures animation and audio. Using your keyboard conttols, the goal is to get Lieutenant Bennert back
to his spaceship safely, jumping between blocks, teleports, switches and more.

silverlight.net/samples/1.0/5prawl/default. html
Sprawl, written for Silverlight, is a tile-capture game in which you play against the computer. The
goal is to capture more tiles than the computer without paving over tiles you have already captured.

cosmik.members.winisp.net/BubbleFactory/

The Bubble Factory game, built with Silverlight, is a simple animated game in which you use key-
board controls to move the bubble dropper left or right and to drop the bubbles. The key is to align
three bubbles of the same color (horizontally, vertically or diagonally) to make them explode.

silverlight.net/samples/1. 1/chess/run/default. html
A simple game of chess built with Silverlight 1.1.
microsoft.blognewschannel. com/archives/2007/06/29/barrel -o-silverlight-games/

The Inside Microsoft blog entry entitled “Barrel O Silverlight Games” includes links to several Sil-
verlight games including Chess, Zero Gravity, Sprawl, Destroy All Invaders, Digger and more.
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silverTightracks.com/community/blogs/silveriight_games_101/default. aspx

A tutotial entitled “Silverlight Games 101: Beginning game programming in Microsoft Silverlight
1.1 using C#” by Bil! Reiss and Silverlight Rocks! Topics include the Zero Gravity game, loading
XAML dynamically, adding chrusts, a berter game Joop, keyboard input, creating 2 game loop and
drawing a sprite. All of the source code for the tutorial is available for download.

blogs.msdn.com/tims/default.aspx
Microsoft’s Tim Sneath blogs about Silverlight and orher Microsoft technologjes. He includes links
to 50+ Silverlight samples, information about the fatest Silverlight releases and other Silverlight news.

waw. junkship.org:8000/silverlightdemo/

The Amazon Search Visualization demo, built with Silverlight. Click the “New Search” button, then
enter the title of the book or author for which you would like to search. Images of each book and
related books appear on the screen. Click the green button on the image 1o get the book details
(including dtle, author(s), reviewer rating, lowest new price and lowest used price). You will also see
a visual presentation of book covers for related books. Click the red button on the book cover to
close that item. Click the “Clear All” button to search for a new book.
dnnsilveriight.adefwebserver.com/Samples/S$ilverlightVideo/tabid/55/Defaul t.aspx
A Silverlight Video module for DotNetNuke allows you to embed a video player in your DotNet-
Nuke site. Check out the demo to view a video in a web page or to view the video full-screen. The
site includes installation and configuration instructions.

www.chriscavanagh, com/Chris/Silverlight/Physics2D-1/TestPage.html

A 2-D Physics Engine has numerous platforms. Click the “Drop Wheels” button to drop tires from
the top of the page onto the varying platforms to see which direction they will roll, Click the “Move
Platforms” button and “Dsop Wheels” to try again.

dev.aol.com/mail

The AOL Social Mail Gadget, built with Silverlight, gives AOL mail users easy access to email, IM,
photos and video and more with just one click. It also allows vou to set up an “A-List” of your most
important contacts so you are awate when they are online, when a message from someone on the
list is received and more.

mib.mlb.com/media/video.jsp

Check out a sample of a Silverlight video player embedded in a Major League Bascball web page.
You can pause and rewind the video and adjust the volume. A link is provided so you can link to the
video from your website.

stlverlight.net/samples/1.0/Grand-Piano/default.html
A Grand Piano application built with Silverlighr includes audio and animation. Click on the key
with your mouse to play 2 note.

www.telerik.com/products/siiverlight/overview.aspx

RadControls for Microsoft Silverlight help you build R1As withour using JavaScript or XAML cod-
ing, Features include layours, animation effects, integration with ASPNET Ajax and more. Check
out the demos to see the features, functionality, appearance and more.

blogs.msdn. com/chowen/archive/2007/07/30/controls-and-control-libraries-for-
silverlight.aspx :

The blog entry entitled “Controls and Control Libraries for Silverlight” by Microsoft’s Chris Bowen,
provides links to some of the reusable Sitverlight conrrols and libraries thart allow you to develop Sil-
verlight applications faster and more efficiendly. You'll also find links to samples and trorials.

silveriight.net/QuickStarts/Buildui/CustomContro}.aspx
The tutorial “How to Create Custom Silverlight Controls™ discusses the control UI and object
model, starting from the Silveright Class Library Project, defining the UT, gerting objecr references,
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adding properties and events for control customization, testing your control and shadowing inher-
ited properties.

silverlight.net/learn/lTearnvideo.aspx?video=207

The video tutorial “How to Build a Silverlight Control” by Jesse Liberty, shows you how to create
an HTML application that interacts with a Silverlight control.

www . codeplex.com/Project/ProjectDirectory.aspx?ProjectSearchfext=silverlight
CodePlex, Microsoft's open source project hosting website, includes a collection of 14 open source
Silverlight projects including iTunes 2.6, Dynamic Silverlight Samples, Silverlight 1.0 JavaScript
Intellisense, Silverlight Playground, Balder, Silverlight Audio Player and more. Each project includes
a description of the project, a demo and the source code.

www.aisto.com/Roeder/Silverlight/

Lutz Roeder’s Silverlighr page provides several sample applications including Monotone
{www.aisto, com/Roeder/SiTver1ight/Monotone/Default.aspx), a graphics application written in
XAML and C#; Digger (www.aisto. com/Roeder/Silverlight/Digger/Default.aspx), a clone of
the Boulderdash game, written in C#; and Inplay {www.aisto.com/Roeder/Silverlight/Inplay/
Default.aspx?Audio=play:false&Video=source:http://download.microsoft.com/downl oad/2/
C/4/2C43315l-F‘SBC-4BAB—BBCS-BBCBF240AFCC/5L_0410_448X256_300kb_2paSSCBR.wmv), an audio
and video player that can be embedded in a web page, built with C#. Download demos of cach
application and gert the source code. .
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: %:Ynnmé embed a Silverlight appliéatiou dneo anexisting HTML file by including the scripts,
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20.1 Introduction

This chapter presents Adobe’s Dreamweaver CS3, perhaps the most popular visual HTML
editor. A fully functional, 30-day trial version of Dreamweaver is available for download
at www.adobe ., com/cfusion/tdrc/index. cfm?product=dreamweaver. Please download-
and install the software before studying this chapter.

Using Dreamweaver, you can easily perform many of the tasks you learned in previous
chapters. You can insert and edit text, as well as create more complex XHTML elemens,
such as tables, forms, frames and much more. In addition, this latest version of Dream-
weaver now enables you to develop Ajax applications with Adobe’s Spry framework.

20.2 Adobe Dreamweaver CS3

Upon starting, Dreamweaver displays the default Start Page, which offers various opt-
ions, such as Open a Recent item, Create New and Create from Samples (Eig. 20.1). For
example, you can click the HTML option under the Create New heading to open a blank
page in the default viewing mode (Fig. 20.2). Dreamweaver is a WYSIWYG (What You
See Is What You Get) editor. Unlike editors that simply display XHTML code, Dream-
weaver renders XHTML elements much as a browser would, using the WYSIWYG
screen. This functionality enables you to design your web pages as they will appear on
the web.

We will now recreate the book’s first XHTML example (Fig. 4.1) using Dream-
weaver. To see a more detailed list of options for creating new files, create a new document
by selecting New... from the File menu. In the New Document dialog, sclect the Blank
page tab from the leftmost column, and HTML from the Page Type: list (Fig. 20.3). By
default, Dreamweaver’s DocType (in the lower-right corner) is set to XHMTL 1.0 Transi-
tional. Select the drop-down DocType menu and select XHTML 1.0 Strict—this will cause
Dreamweaver to generate XHTML-compliant code. In the Layout: list, make sure <none>
is selected. Click the Create butron to open the new document.
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Fig. 20.1 | Dreamweaver Start Page.

Fig. 20.2 | Dreamweaver editing environment.
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Fig. 20.3 | New Document dialog.

Type
Welcome to XHTML!

in the Document window. Dreamweaver automatically places this text in the body element.
Note that XHTML tags are not currently visible. We will switch to an alternate view in a
moment to see the code that Dreamweaver generates. Now, to insert a title as we did in
Fig. 4.1, right click in the Document window and select Page Properties... from the
popup menu to view the Page Properties dialog (Fig. 20.4).

i
Fig. 20.4 | Page Properties dialog.
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The Category list lets the user select a set of properties to view. Select Title/Encoding
from the Category list and enter Internet and WWW How to Program into the Title field.
Clicking OK inserts a title element with the corresponding title text inside the head ele-
ment of your XHTML code. [Noze: You can also create a title by entering text directly
into the Document title box (Fig. 20.6).] You now have a representation of the code in
Fig. 4.1 in the WYSIWYG display (Fig. 20.5).

Though you have been editing using the WYSIWYG display, remember that you are
still programming in XHTML. To view or edit the XHTML that Dreamweaver gener-
ated, you must switch from Design view, the mode you are currently working in, to Code
view. To do so, click the Code button in the Document toolbar (Fig. 20.6). Note that
Dreamweaver automatically color-codes XHTML to make viewing easier (Fig. 20.7). The
tag names, attribute values and page text are all displayed in different colors. The code-
coloring scheme can be accessed (and modified) by selecting Preferences... from the Edit
menu and clicking Code Coloring in the Category list.

To save your file, click Save in the File menu or press <Cirl>-S. The Save As dialog
will appear, allowing you to specify a filename, type and location (Fig. 20.8). Create a
folder in your C: drive named Dreamweaver sites. Type main into the File name ficld and
select HTML Documents as the file type. Dreamweaver adds an .htm1 filename extension if
no extension is specified.
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Fig. 20.7 | Code view.

Fig. 20.8 | Save As dialog.

To view your page in a browser, press F12 or select Preview in Browser from the File
menu. Note that the File menu option provides several browsers in which to view your
code—more browsets can be added with the Edit Browser List... option. Your page should
appear identical to the one in Fig. 4.1.

20.3 Text Styles

In Dreamweaver, we can alter text properties with the Text menu or the Property Inspec-
tor (Fig. 20.2). Using thesc tools, we can quickly apply heading tags (<hi>, <h2>, etc.), list



Adobe Dreamweaver CS3 a0s

tags (<01>, <u1>) and several other tags used for styling text. Text can also be aligned left,
right or centered, resized, indented and colored.

Create a new document, switch back to Design view and type the text, as shown in the
screen capture of Fig. 20.9, into the Document window. Drag the mouse to highlight one
line at a time and select the corresponding heading tag from the Format pull-down menu
in the Property Inspector. Then, highlight all the text by pressing <Cer/>-A, and click the
align center button in the Property Inspector. The resulting XHTML produced by Dream-
weaver is shown in Fig, 20.9.

As you can see, Dreamweaver is prone to produce somewhat inefficient code. In this
case, for example, using Cascading Style Sheets (CSS) to center the text would have been
more efficient. At the end of this section, we discuss how to integrate CSS into your web
page without having to edit the XHTML in Code view.

Level 1 Heading
Level 2 Heading

Level 3 Heading
Level 4 Heading
Level 5 Heading

Lo & Mouling

Fig. 20.9 | Applying heading tags and centering using Dreamweaver.
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Software Engineering Observation 20.1

Dreamuweaver uses text-manipulation technigues that sometimes produce inefficient code. Make
& c1ire 10 check the code often to know exactly the kind of XHTML Dreamweaver is producing,
Thorough knowledge of a page and what XHTML elements are present is necessary for advanced
sScrIpting.

Dreamweaver is capable of much more extensive text formarting, such as creating
machematical formulas. For example, type

e = mc2

into a new WYSIWYG window, then highlight the text. You can now change the formar-
ting of the equation by selecting Style from the Text menu, and selecting Code. The Code
option applics a code clement to the highlighted text, which designates formulas or com-
puter code, Many other useful text-formatting options are located in the Text menu, as
well. Click the Code button in the Document toolbar to view the code, and find the 2 in
the equation. Surround the 2 with a <sup>...</sup> tag. The <sup>...</sup> tag formats
the enclosed text as a superscript. Notice thar after typing <sup>, Dreamweaver automat-
ically completes a matching end tag {</sup>) after you have entered the </ characters.
Click the Design button in the Document toolbar to view the fully formatted text
(Fig. 20.10).

The formula can be further emphasized by sclecting a Color... attribute from the Text
menu. You can also access most of the elements in the Text menu (though not the color
attribute) by right clicking highlighted rext.

_Look-and-FeeI Observation 20.1

' When you press Enter after typing text in Design view, Dreamweaver encloses that text in a new
paragraph (p) element. If you want to insert only a <br /> tag into a page, hold Shift while
pressing Enter.

- Look-and-Feel Observation 20.2

" Xy You can manipulate the properties of almost any element displayed in the Dreamweaver window
b L by right clicking an element and selecting its properties from the menu that paps up.

Fig. 20.10 | Styling text using code and sup elements.
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The Property Inspector is also useful for creating lists. Try entering the contents of a
shopping list, as shown in Fig. 20.11, and applying the Unordered List style ro the list ele-
ments. Apply an h2 element to the title of the list.

Select List from the Text menu for more list-related tags, such as the definition list
{<d1>). There are two list elements in a definition list—the defined term (<dt>) and the
definition data (<dd>). Figure 20.12 shows the formatting produced by a definition list
and the code Dreamweaver uses to produce it.

To apply the definition list as shown, select Deflinition List from the List submenu of
the Text menu. In the Document window, type the first term you want to define. When
you press Enter, Dreamweaver changes the style to match that of a definition. Pressing
Enter again lets you enter another defined term. The bold style of the defined terms is
applied by clicking the Bold button in the Property Inspector, which applies the strong

element.

Fig. 20.11 | List creation in Dreamweaver.

Fig. 20.12 | Definition list inserted using the Text menu. (Part | of 2.)
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Fig. 20.12 | Definition list inserted using the Text menu. (Part 2 of 2.)

Creating Style Sheets

Dreamweaver provides powerful tools to integrate CSS easily into existing code. Type

Deitel Textbooks

Internet & World Wide Web How to Program, 4/e
Java How to Program, 7/e

Visual Basic 2005 How to Program, 3/e

C# For Programmers, 2/e

into the WYSIWYG display. Make the last four lines into unordered list efements using
the method described above.

Select CSS Styles from the Window menu, or press <Shifé>-F11. The CSS Styles panel
will appear on the right-hand side of the page (Fig. 20.13). Now, click the New CSS Rule
icon (Fig. 20.13) to open the New €SS Rule dialog. Next to the Selector Type: prompt,
select the Tag option, This designates your style selections to the particular tag selected in
the Tag: prompt. Enter u1 into this menu’s text box, or select it from the drop-down list.
Next to the Define in: field, select the This document only radio button to create an
embedded style sheet. The (New Style Sheet File) option generates an exrernal style sheet.
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Fig. 20.13 | CSS Styles panel.

Click OK to open the CSS Rule definition dialog. Type should already be selected in
the Category menu. Next to the Decoration: field, check the underline box. Now select
Background from the Category list, and enter #66ffff into the Background color: field.
Click OK to exit the dialog and return to the Design view. The text within the <u1> and
</ul> tags should now appear as in Fig. 20.14.

Fig. 20.14 | List with styles applied using CSS.
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Now click the New CSS Rule icon to bring up the dialog again. This time, select Class
under Selector Type:, and next to Name: enter special. In the CSS Rule definition dialog,
select x-large from the Size: menu. Click OK to return to Style view, and highlight the
word Deitel. Then right click the text and select CSS styles from the menu that appears.
In the new menu, click special ro apply the new class to the selected text. Your page should
now appear as in Fig. 20.14.

Select the All option under the CSS Styles tab of the CSS Styles panel. There should
now be a <style> tag in the All Rules window. Click the plus sign o its left to expand the
category. Note that the two style rules that you creared are present in this menu, and that
additiona! properties can be added by selecting the rule, then clicking the Add Property
link in the panel. Also, clicking a property’s value in the CS$ Styles panel creates a drop-
down menu, allowing you to specify a new value for the property.

Switch to Code view to see the style sheet that Dreamweaver has generated for you.
Note that a <span> element was automatically created to contain the special class.

Please refer to

www . adobe. com/devnet/dreamweaver/css . htmi

for additional information on using CSS in Dreamweaver.

20.4 Images and Links

Inserting images using Dreamweaver is simply a marter of clicking a button and selecting
an image to insert. Open the Select Image Source dialog (Fig. 20.15) either by selecting
Image from the Insert menu, clicking the Images menu (Fig. 20.2) in the Insert bar and sele-
cting Image, or pressing <Cir{><Alt>-1. Browse your local hard-drive directory for a JPEC,
GIF ot PNG image. You can view the image’s URL in the URL field—this will become the
image’s src attribute, which can also be viewed in the Src field of the Property Inspector.

AGAI7EGIF, K7 aie

Rl rosomeare soscomel gl
"] Uniteei

Chaooe deteuk Link olgiive To# the ske
Documert shoukd be saved o use #ee option.

Fig. 20.15 | Image souice selection in Dreamweaver.
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Software Engineering Observation 20.2

B \When you insert a local image into an unsaved document, Dreamweaver sets an absolute path,
such as File: ///Cl /Dreamveaver sites/camel.gif. If the image is stored in the same folder
as the .himl file, saving the document sets the image source to a relative path, starting as the folder
in which the document is saved {e.g., camel.gif).

After inserting your image, select it in the Document window and create a hyperlink
using the Link field in the Property Inspector (Fig. 20. 16). Type in the URL to which the
hyperlink will point, http://www.deitel.com. Using the Border ficld of the Property
Inspector, add a border = 0 attribute to the <img> tag to remove the blue rectangle that
normally appears around the image.

You can also change other image artributes in the Property Inspector. Try resizing the
image using the height and width fields and changing irs alignment in the Align pull-down
menu. Clicking and dragging an image’s borders also resizes the image.

“eooe Y
o mEIEBOA
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Fig. 20.16 | Image properties in the Property Inspector.

20.5 Symbols and Lines

Dreamweaver allows you to insert characters that are not located on the standard key-
board. These characters are accessed by slecting HTML in the Insert menu, then selecting
Special Characters. Select Other... from the Special Characters submenu to view the Insert
Other Character dialog, which contains a list of various characters (Fig. 20.17).

Fig. 20.17 | Insert Other Character dialog.
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In the next example; we demonstrate how these symbaols can be used in a web page,
along with Dreamweaver’s horizontal rule feature. Begin by typing

10 + 5 =

Use the Insert Other Character dialog to insert the divisioti symbol. Then, select HTML from
the ingent menu and click the Horizontal Rule button: This action inserts a line (hr ele-
ment) onto the page directly below the cursor’s position. The line should be selected by
defauly; if it is not, select the line by clicking it once. Using the Property Inspector, set the
width to 60 pixels by entering 80 in the W field and selecting pixels from the pull-down
menu directly to its right (Fig. 20.18). The other value in the menu, %, sets the line's
length to the specified percentage of the screen. Make the line § pixels high by entering &
in the H field (values in this field always have pixels as their units). Select Left from the
Align pull-down menu.

On a new line, type the number 2. Insert another horizontal rule below the 2. Set its

height to 10 pixels and width to 100%. The page should now resemble Fig. 20.19. -

Fig. 20.19 | Special characters and hr elements in Dreamweaver.

20.6 Tables

As useful as tables are, they often are time consuming and confusing to code by hand in
XHTML. Dreamweaver offers easy-to-use table-editing commands. Open the Table dia-
log by selecting Table from the Insert menu, clicking the Table button in the Insert bar or
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pressing <Cerl><Alt>-T. The Table dialog (Fig. 20.20) allows us to select the number of
rows and columns, the width of the table and several other related settings.

Figure 20.21 is a simple table with two rows, two columns and no border. Once the
table is placed, you can manipulate its size. Click in a cell and press <tr> in the tag selector
(Fig. 20.2) at the bottom of the Document window to select that row. Pressing the Delete
key removes-the row from the table. You can highlight an individual ceil by clicking <td>
in the tag selector. Holding down the Ctr/ key, then clicking multiple cells allows them all
to be selected simultaneously. Clicking the Merge Cells button in the Property inspector
while two adjacent cells are selected combines the cells into one (Fig. 20.22). Dream-
weaver uses the colspan and rowspan attributes of the <td> tag to merge cells. Select a cell
and dlick the Split Cell button in the Property Inspector to open the Spiit Cell dialog, which
allows you to divide the selected cell into any number of rows or columns (Fig. 20.23).

The Property Inspector allows us to manipulate the selected table, or a portion of the
table. While a cell is selected, its text attributes can be adjusted just as we demonstraced
earlier in the chapter. In addition, background and border colors can be assigned to cells,
groups of cells or an entire table. We can adjust a cell’s height and width in the Property
Inspector. To manually adjust a cell’s size, you can also click and drag its border lines.

Fig. 20.21 | Table with two rows and two columns.
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ST

Fig. 20.23 | Spiit Cell dialog.

We now recreate the table of Fig. 4.11. Make 2 four-row and five-column table that
spans 90% of the page with a one-pixel border. Click the top-left cell, hold the Shiff key
and click the cell below it—another way to select multiple cells. Two of the leftmost cells
should now be selected. Merge them by righr clicking in either cell and selecting Table >
Merge Cells (Fig. 20.24) or select Merge Cells in the Property Inspector as we did before.

Quick Tag Editor ..
Make ok
e e d P

Fig. 20.24 | Merging cells in a table.



Adobe Dreamweaver C53 815

' To make space for the title of the table, select the top four cells (again using the Shift
key) and merge them together. The layout of the table should now resembie Fig. 20.25.
Now, type in the texr and insert the image.

To increase the visual appeal of the table, add color by selecting the desired cells and
adjusting their background color in the Property Inspector. The size of rows and columns
also can be adjusted by changing the H (height) and W (width) field values in the Property
Inspector or by clicking and dragging the boundaries between cells.

= - e B P

1 Table Example Page

Here b mmote cotplex dingle table,

Camelid comparison

Fig. 20.25 | Almost completed table.

20.7 Forms

All the necessary XHTML coding needed for creating a feedback form or any other forms
can be done in Dreamweaver. To insert a form, first select Forms from the insert menu in
the Insert bar (Fig. 20.26). The Insert bar will now conrtain various options for creating
forms. Click the lefrmost burton to insert an empty form into the document. Forms can
also be inserted by selecting Form from the Insert menu’s Form submenu.

After a form is inserted into a document, Dreamweaver displays a dotted line to delin-
eate the bounds of the form. Any form objects (i.e., text fields, buttons, etc.) placed inside

Fig. 20.26 | Forms Insert bar.
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this dotted line will be parr of the same form element in the XHTML code that Dream-
weaver generates.

We can modify the properties of a form by clicking anywhere inside the dotted line
thar delineates the form, then clicking <form#name> (where name is the name of the form
element) in the tag selector at the bottom of the Document window. Dreamweaver assigns
default names to forms in sequential order (i.e., the first form inserted is named form1, the
second form is named form2 and so on). The name of the form can be altered in the Form
name field in the Property Inspector. The Property Inspector can also be used to set the
Action and Method attributes of the form, which are required for server-side processing.
Server-side technology is discussed later in this book.

You can insert text field by clicking the Text Field button in the Insert bar or by
selecting Text Field from the Insert menu’s Form submenu. The Input Tag Accessibility
Attributes dialog thar appears allows you to set an 1d and Tabe1 for the text field, and to
specify some of its other properties. Once placed, a text field’s attributes can be adjusted
using the Property Inspector. Its name, id and value attributes can be set-or modified along
with the size and max1ength (Fig. 20.27). The text field type also can be set to Multi line,
allowing multiple lines of text, or Password, making all entered text appear as asterisks (*).

Scrollable Textareas also can be selected from the Form Insert bar. Their properties
are almost idenrical to those of a text field, except that they have the additional attributes
for the number of lines (specified in the Num lines field in the Property inspactor) and Wrap
(i.e., how the text area handles lines of text that exceed its width).

A drop-down select menu can be added by clicking the List/Menu button in the Ingert
bar. To add entries and values to the list or menu, click the List Values... buttor in the
Property Inspector (Fig. 20.28). In the List Values dialog, you can add entries by pressing
the + button, and remove entries by pressing the - button. Each entry has an item Label
and a Value. An entry can be made the default selection by selecting it in the initially
selected list in the Property Inspector.

Now that we've discussed the basics of forms in Dreamweaver, we're ready to create
a “rate my website” form. To start, insert a form into a new page, followed by text fields,
menus and text. The elements should appear as in Fig. 20.29.

Make the text fields the proper width by adjusting the Char width value in the Property
Inspector. Now select the drop-down menu to the right of the text How would you rate our
site? and click the List Values... burton in the Property Inspector to add appropriate entries
to the list (e.g., Excellent, Good, Fair, Poor and Terrible}.

Fig. 20.27 | Text field Property Inspector.



Adobe Dreamweaver CS3 817

:waﬂdywmowsi:? - Chonss One - ﬁ

:Cem?

M oukd you lke 10 be on our mailing kst?

50 Yes
0 No
{© Dot Care

Fig. 20.29 | Completed form.

This example has three radio buttons, all contained in the same group. To add a group
of radio buttons, click the Radio Group button in the Insert bar. In the Radio Group dialog,
specify the Name of the group, and each radio button’s Label and Value. The Radio Group
dialog works similarly to the List Values dialog,
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To create the Reset and Submit buttons, click the Button selection in the Insert bar.
The Value of each new button defaults ro Submit, but can be changed to Reset or any other
value using the Property Inspector. The button’s Property Inspector can also be used to
assign a Button nama, which is assigned to the button’s name and id atributes, or to specify
its Action, or type attribute. :

For a complete list and description of Dreamweaver’s XHTML tags, open the Refer-
ence panel by selecting Raference from the Window menu. Select the desired XHTML
element from the Tag pull-down list in the Reference panel.

20.8 Scripting in Dreamweaver

Dreamweaver also allows us to add JavaScript to our pages manually in the Code view or
automatically using the Behaviors panel. To open the Behaviors panel, either select
Behaviors from the Window menu, or press <Shift>-F4. The Behaviors panel appears as a
tab option in the Tag panel (Fig. 20.30}.

The Behaviors panel allows us to add commands to elements of a web page that trigger
various JavaScript actions in response to browser events. To add an action, select an ele-
ment on the page. Click the + button in the Behaviors panel to display a pop-up menu of
applicable actions. The pop-up menu offers several predefined JavaScript actions, such as
Go To URL or Popup Message. A developer also can manually write an action by selecting
Call JavaScript from the pop-up menu and entering the desired code into the Call Java-
Script dialog. Selecting Get More Behaviors... opens a web page thar provides options to
download or purchase additional behaviors, extensions, functions and code. After com-
pleting the dialog associated with the selected action, the action and a default event appear
in the Behaviors panel. A developer can change the event thar wriggers this action by
clicking the event field and choosing an event from the drop-down list that appears.

Dreamweaver supports several server-side scripting languages, discussed later in the
book, such as ASP.NET, JSF, PHP and ColdFusion. Server-side scripting clements, such

St Mpv B3 asge

Set Text

it Hide Elements
image

Sweap Image Restore

Timelne

Walaate Form

Fig. 20.30 | Behaviors panel and menu to add behaviors.
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as Databases and Bindings, can be accessed in the Window menu. Tags of the various lan-

"guages can also be selected from the Tag Chooser, which is accessed by selecting Tag...
from the Ingert menu, or from the icon in the Insart bar (Fig. 20.2). Dreamweaver allows
the user to add scripting elements only where applicable.

20.9 Spry Framework for Creating Ajax Applications

Many toolkits are available that provide prebuilt controls to enhance web applications and
make it easier to include JavaScript functions in your applications with minimal coding
(such as the Dojo toolkit mentioned in Chapter 15, and the Prototype and Script.aculo.us
toolkits in Chapter 24). Adobe also created its own toolkit for Dreamweaver to develop
dynamic and more robust web pages known as the Spry Framework.

The Spty Framework enables web developers with basic knowledge of HTML, CSS
and JavaScript to create richer websites and dynamic pages. The framework includes a
ready-to-use JavaScript library, which contains prebuilt, but customizable, widgets (such
as a Validation Textarea, Validation Text Field and a Menu Bar), effects (such as grow, shrink,
fade and highlight) and Ajax capabilities. To view all of the available spry tools, click the
Spry tab in the Insert bar (Fig. 20.31).

Recall that Ajax applications separate client-side user interaction and server commu-
nication and run them in parallel, making the delays of server-side processing more trans-
parent to the user. Consider the form example that you built in Fig. 20.29. None of the
data entered into the form is transmitted to the server until the user clicks the Submit
button. At that time, any errors in the form are sent back to the user for correction. With
Ajax and the Spry framework, text field input is validated on the client side. When the page
loads, the files that provide the validation are loaded directly into the page, so you can
check for errors in any given field as soon as the user moves to the next field in the form.

~ Now, let’s rebuild the form in Fig. 20.29 using Spry controls. First, insert Spry Vali-
dation Text Fields next to the Name and E-mail Address labels.

Select the blue Spry box connected to the text field you created next to the E-mall
Address label. In the Property Inspector, set the Type: to Email Address. Make sure that the
Change checkbox is selected. This means that a valid e-mail address must be in the field
and if any changes are made to the address, the client will display a message prompting the
user to make a change before continuing (Fig. 20.33).

Fig. 20.31 | Spry Tools.
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Fig. 20.33 | Using a Spry Text Field to validate data before continuing to fill out a form
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Our application detects an error when validating the information in the e-mail
address text field. As soon as we try to move to the next field, the application displays the
error Invalid format to let us know that we must correct the information that we originally
typed into that field.

Real-time validation is a key element in Ajax and rich Internet applications. The
framework also provides capabilities for loading and processing XML data obtained via
Ajax interactions with the server. Using the Spry Framework, developers can take advan-
tage of such rich functionality, even if they don’t have a deep understanding of XML and
JavaScript. For more information on the Spry framework, for Ajax-based examples and for
the latest version of the framework, visit 1abs.adobe.com/technologies/spry/.

20.10 Site Management

In this book, we focus primarily on the skills and technologies involved in creating indi-
vidual web pages. As a result, we do not spend much time discussing complete websites.
Creating an effective website is a difficult process, requiring planning, effort and time.

Dreamweaver is a powerful tool for creating and maintaining a website. To create a
site using Dreamweaver, first open the Files panel either by selecting Files from the
Window menu or by pressing F8. Click the Manage Sites... link in the Files panel’s drop-
down lift, or click the link to the right of this menu, to open the Manage Sites dialog.
From this dialog, a developer can access previously created websites or create new ones. To
create a new website, click the New... button in the Manage Sites dialog and select Site from
the pop-up list. Then, follow the instructions provided by Dreamweaver's Site Definition
Wizard. Once completed, site files can be viewed, accessed and added in the File panel.

In general, pages in a website should have consistent colors and styles to maintain site
uniformity. Dreamweaver’s Assets panel holds elements common to a website, such as
pictures, colors and links. Open the Assets panel by selecting Assets from the Window
menu or pressing FI1.

While Dreamweaver is a valuable aid in website creation, it is not a replacement for
thorough knowledge of XHTML and the related scripting languages taught in this baok.
Be sure to familiarize yourself with these other technologies before using Dreamweaveir to
accelerate the development process.

20.11 Web Resources

www . adobe. com/devnet/dreamweaver

Adobe’s Dreamweaver Developer Center contains numerous tutorials and sample files intended for
beginner, intermediate and expert users, This site explores some of the more advanced features of
Dreamweaver in addition to the topics covered in this chapter.

waw . adobe . com/software/dreamweaver
This site contains detailed product informartion, software downloads and links to featured sites cre-
ated with Dreamweaver C53.
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